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Congratulations on your purchase of Finale 2010 for Windows! 
 
IMPORTANT: Read this document before you begin working with Finale 2010 and print a copy of it to keep with 
your Finale information.  
 
This file contains important information about Finale 2010 not included in the User Manual as well as information 
about converting older files into the new version's format. Please note that Finale 2010 files cannot be opened in 
previous versions of Finale. 
 
This document is organized by each version's changes; those of you already familiar with earlier versions may wish 
to read only the new information. The Read Me contains the following sections: 
 
Running Finale 2010 
New features in Finale 2010a 
New features in Finale 2010 
Fixes in Finale 2010b 
Fixes in Finale 2010a 
Fixes in Finale 2010 
 
You may also visit our web site, www.finalemusic.com for updated information about Finale and information on 
new releases.  
 

Running Finale 2010 
 
System Requirements 
Windows XP/Vista/7 32-bit (64-bit compatible). 500MB hard drive space required for software and user manual. 
 
DVD-ROM drive. 800x600 minimum monitor resolution. Minimum 512MB RAM (1GB or more recommended for 
optional use of Garritan and Tapspace (VST) sounds: more RAM = more available sounds.) An additional 2 GB 
hard drive space is required for all included VST sounds. 
 
Optional:   
MIDI interface. MIDI input and/or playback device. Printer. Scanner. Microphone required for use of MicNotator®. 
A soundcard (including Standard DirectSound, MME, or ASIO drivers) is required for playing the VST sounds in 
Windows. 
 
Additional VST instruments will perform best with faster processors and hard drives. 
 
Installing Finale 2010 
If any previous version of Finale has been installed on the machine, Finale 2010 recommends that you restart your 
computer and log on as System Administrator before installing. This will prevent erroneous font warnings. 
 
We recommend that you install Finale, and any other software, when logged in as System Administrator. 
 
If you encounter problems during installation, we recommend that you do the following: 
 
1. Turn off any programs running in the background. Virus detectors can often prevent Finale from installing  
 necessary files and updating the registry. Rest assured, your Finale CD does not contain any viruses. 
2. Press Ctrl-Alt-Delete, then click on Task Manager and then the the Process tab. In the Processes Tab, click 



 on "User Name" to sort the running programs by user ID name. This lists every process that is running on  
 the system. 
3. Under the User Name column, look at all of the processes ("Image Name") with your account name. Click  
 on each one, and then click "End Process" and select OK.  Do this for every process assigned to your name 
 except “taskmgr.exe”, “explorer.exe”, and “System Idle Process.” 
4. Close the Task Manager. 
5. Check your system tray (lower-right corner of the screen) to see if any programs are running. Right-click  
 each of these and choose Close - especially antivirus software, which does interfere with programs properly 
 installing. 
 
Authorizing Finale 2010 
The first time you launch Finale, you will be prompted to authorize. To authorize a single copy of Finale, click 
Authorize Now! to open the Authorization Wizard (or, from the Help Menu, choose Authorize Finale). Then follow 
the instructions to authorize your copy of Finale via the Internet, phone, or mail. If you choose not to authorize, you 
will be prompted to do so each time you launch Finale. If you do not register within thirty days, printing and saving 
are disabled until you choose to authorize. 
 
Note that the User/Authorization Codes are computer specific, and will only work on the given computer 
installation. Make sure that the Authorization Code is typed in using capital letters, and also verify that the correct 
serial number has been entered. Your copy of Finale can be authorized on two computers simultaneously, and, with 
an Internet connection, authorization can be moved from one computer to another at will. Simply choose 
Deauthorize Finale from the Help Menu to open up a free slot. Your copy of Finale can now be authorized on a 
different computer. When you Deauthorize, printing and saving are disabled until authorization has been restored. 
 
If you make a change to the computer (such as replacing the hard drive or motherboard, or installing a new operating 
system), then you will need to re-authorize the installation. If you have already installed and authorized twice, you 
will need to contact Customer Support online at www.finalemusic.com/support with your serial number and the 
location ID for the specific installation in question. If the software is not "reminding" you to authorize when you run 
the program, then the registration/authorization has been successfully completed. 
 
Starting Finale 2010 - DLLs 
Most applications (including MakeMusic products) require a set of files, the Microsoft redistributables, in order to 
work successfully on your system. These redistributable files are normally already present on most systems and are 
not generally included in application setup/install scripts - doing so would add about 1.5 MB to the size of the 
package, and cause a longer installation process. More importantly, as these files are constantly updated by 
Microsoft and are operating-system specific, including these files in an application installer could result in incorrect 
files being added in your system and subsequent problems. 
  
In rare cases these files may be missing or out of date on your system. In this case an error will be reported when 
you start the program. Here are some examples of the errors that could be reported:  
If the files are missing...  
'The dynamic link library MSVCP60.DLL could not be found in the specified path...' 
or  
'The dynamic link library MSVCRT.DLL could not be found in the specified path...' 
If the files are out of date...  
'The OCXTS.EXE file is linked to missing export MFC42.DLL:6880.' 
 
If you see one of these messages, visit www.microsoft.com for more information regarding these files and how to 
restore them. 
  
Online User Manual 
For full documentation on how to use Finale 2010, see the User Manual. To access the User Manual, choose the 
Help menu, then User Manual. If you have an Internet connection, Finale opens the User Manual using your default 
browser and accesses the latest online content from MakeMusic’s servers. If you do not have an Internet connection, 
Finale automatically opens the local version of the User Manual that was installed on your hard drive along side 
Finale 2010. 



 
 
Sample Files 
Finale includes a collection of scores that demonstrate some of Finale's notation and playback capabilities. These 
files are located in the Finale 2010/Sample Files folder. 
 
Vista and Exporting EPS Graphics 
Windows Vista uses a new True Type font format that is not compatible with Finale’s EPS export mechanism. As a 
result, Vista users will notice the "Include Fonts" check boxes have been removed in the Export Selection and 
Export Pages dialog boxes. Including fonts in exported EPS graphics is still fully supported in Windows XP. 
 
Importing 
Finale no longer supports import of the following file types: Encore (.ENC), Rhapsody (.RHP), MIDIScan (.MND), 
SmartScore (.FIN), and SCORE. Finale does support the importation of MusicXML files (under the File menu). 
 
Easy Measure Numbers plug-in 
The Easy Measure Numbers plug-in has been removed in favor of Finale's integrated measure number functionality. 
 
MiBAC Jazz Rhythm Section Generator plug-in 
The MiBAC Jazz Rhythm Section Generator plug-in has been removed from Finale 2010. 
 
Kodály Templates 
Finale’s Kodály templates have been removed from the initial release of Finale 2010. 
 
Export Lyrics plugin 
The former Extract Lyrics plug-in has been removed in favor of the new Export Lyrics feature under the Lyrics 
menu. 
 
Playing QuickTime Videos in Finale's Movie Window 
To play QuickTime videos in Finale for Windows, QuickTime (a free download at www.apple.com) must be 
installed on your computer. Movie files saved in Windows Media Player formats do not require QuickTime. 
 
Sharing Finale Documents Online with Finale Reader 
Finale Reader provides a free, reliable, easy way to view and playback Finale documents downloaded from the 
Internet. To open a Finale (MUS) file available at Finale Showcase, or another online resource, viewers now need to 
simply download the file to their local machine and then open it in Finale Reader. This means all Finale 2010 files 
posted on the Internet will be available for viewing on all machines. Finale Reader is available for download free of 
charge at www.finalemusic.com/reader.  
 
Contacting Customer Support 
For Finale support, visit www.finalemusic.com/support. 
 
Converting Finale 2009 (and earlier) documents into Finale 2010 documents 
Finale 2010 has a different file format than earlier versions, and converts older files to the new format when you 
open them in Finale 2010. Finale 2010 will open and convert older versions' documents, giving them the default title 
"UNTITLED.MUS." We recommend saving a newly converted document with a different name than the original 
file, keeping the older unconverted file as a backup. If you do want to save the file using the same name, choose 
Save As from the File menu. Finale displays the original file name, so you can click OK to rewrite over the old file. 
 
Running older versions of Finale 
Finale 2009 (and earlier versions) for Windows or Macintosh cannot open any standard Finale 2010 file. To open a 
Finale 2010 document in an earlier version, save the file in MusicXML format and then open the MusicXML file 
using the MusicXML Import plug-in. Finale for Windows includes the MusicXML importer back to version 2003, 
and then back to 2000 using software available separately. Finale for Macintosh supports Music XML import back 
to version 2004 (OS X only) using software available separately. See www.recordare.com/finale.  



 
 
New Features in Finale 2010a 
For complete information, see the "What's New" topic in the Finale 2010 User Manual.  
 

Enhanced integration of Staff Styles and Linked Parts. Apply Staff Styles to only the part or score you are 
viewing, and easily update staff styles in a score to match its part and vice versa. 

271 Classroom and 126 Individual Flash Cards designed to printed double-sided (with the answers on the 
back). Topics include keys, note names, rhythm, vocabulary, and musical symbols.  

30 Ear Training Worksheets. Designed to be used with the free, downloadable Finale Reader, students can 
print the worksheets, use Reader to play the examples, and write the answers on the printed worksheets. Topics 
include intervals, chords and melodic dictation. 

The Finale Worksheets are now available from the File menu. 

Finale is now compatible with Windows 7. 

New Percussion Functionality including new options in the Percussion MIDI Map Editor that allow you to 
create new, custom percussion MIDI maps. 

 
New Features in Finale 2010 
For complete information, see the "What's New" topic in the Finale 2010 User Manual.  
 

Easier Percussion Entry. Entering percussion has been greatly simplified with on-screen feedback that 
displays the percussion instrument you are about to enter. 

New Percussion Layouts. Assigning the staff position and notehead for percussion instrument staves has never 
been easier with Finale's new percussion layouts. 

Percussion MIDI Maps. To assign the appropriate MIDI notes to your percussion parts automatically when 
you change the playback instrument, use the Percussion Map column of the Instrument List.  

Beat-attached Chord Symbols. Chord symbols are now beat-attached, and no longer require a host note or 
rest. Notes beneath chords can be edited autonomously. 

Improved Chord Playback. Chord symbols now play for the duration of the measure, or to the next chord 
symbol. Simply type "N.C." (for no chord) to interrupt chord playback.  

Improved Chord Input. Type-in and/or Play-in chords without changing modes. 

Chord scaling. Chord symbols resize with the page automatically. Chords and fretboards can be scaled for a 
whole document in Document Options-Chords, or for a region using the Change Chord Assignments dialog 
box. 

Automatic Rehearsal Marks. Adding, deleting, and ordering rehearsal marks is now simple and completely 
automatic. 

Improved MusicXML. Finale’s updated MusicXML capabilities include enhanced recognition of chord 
symbols and fretboards. 

Alternate Notation. Finale now offers more control over what elements are shown or hidden when you apply 
alternate notation.  

Music Education Worksheets. Finale now includes hundreds of ready-made, educator-approved, music 
education worksheets.   

Improved Graphic Support. Finale now supports more graphic file types for import AND export. New import 



support includes JPEG, PNG, BMP, and GIF while new export support includes JPEG and PNG. 

Broadway Copyist Handwritten Music Notation Font. Finale 2010 includes the new Broadway Copyist 
music notation font, created by Robert Piechaud, designer of the esteemed November and Medieval music 
fonts. Inspired by the golden era of handwritten Broadway scores, the Broadway Copyist font offers a lighter 
appearance. 

Audio and Playback Enhancements (including support of VST/AU Effects Plug-ins). Finale 2010 now 
supports VST/AU effects plug-ins, includes the Garritan Ambience reverb plug-in, and offers expanded volume 
control. 

Export Lyrics. Finale’s Lyrics Tool makes it easy to export all or part of your lyrics to a word-processing 
document, and offers new controls to edit your lyrics (adding verse/chorus designations not found in your score, 
for example) before you export to the clipboard. 

Improved Scanning/SmartScore Lite Enhancements. Finale now includes SmartScore Lite version 5, 
offering the best music scanning ever. A new interface lets you specify the instrumentation of the scanned 
staves, ensuring transposing instruments are translated correctly.. 

Improved Help. Not only is Finale easier to use, finding help when you need it is easier too! You will notice a 
cleaner Help Menu, convenient User Manual welcome screen, and improved topic organization. Powerful filters 
allow for targeted searches, which allow you to eliminate clutter and quickly identify the content you need. 

Smoother On-Screen Appearance. Finale's on-screen display now features anti-aliasing for smoother 
on-screen appearance (curves in particular) and more accurate on-screen representation of your final output. 

Transparent Handles. Finale's selection handles make it easy to move anything in your score with great 
accuracy. In Finale 2010 we've made them transparent, so they never obscure what you're trying to edit. 

Hyperlink Support. Easily add Hyperlinks to your Finale score. Clickable links appear when viewing your 
files in other Finale family notation products (including the free Finale Reader) as well in exported SmartMusic 
accompaniments. 

 
Fixes in Finale 2010b 
 
Chords 

• Deleting a measure stack no longer deletes chords in the subsequent measure. 
 
Copy/Paste 

•  Time Signature changes now copy correctly when notes are excluded in the Edit Filter dialog box. 
 
Linked Parts 

• Expressions and chord symbols in the score no longer move when their corresponding items are moved 
across a barline in a linked part. 

 
Percussion 

•  All Row-Loff percussion sounds are now defined correctly for MIDI input. 
 
Selection 

• Problems regarding non-contiguous measure selection have been resolved. 
 
Staves 

• Special Part Extraction now works properly for staves requiring multimeasure rests. 
 
Worksheets 

• Chord playback has been corrected in some ear training worksheets. 



Fixes in Finale 2010a 
 
Articulation tool 

• Changing the definition of an articulation no longer occasionally causes Finale to hang. 
 
Copying and Pasting 

• Measures concluding with grace notes now copy and paste properly. 
• Copying and pasting from multiple-staff documents to a Tempo Tap staff now works for multiple measures 

at a time. 
 
Documentation 

• The User Manual now opens in Windows Vista and Windows 7 using IE8 when not logged in as the system 
administrator. (This fix applies to systems with an Internet connection). 

• The User Manual now opens using the default browser. (This fix applies to systems with an Internet 
connection). 

 
Expressions 

• Shape Expressions no longer have an extra-large footprint when selected with the Selection Tool. 
• Deleting measures or systems no longer occasionally causes subsequent staff list expressions to be deleted. 

 
Movie Window 

• The path and size of imported movies is now retained while saving. 
 
Other 

• Finale now runs on machines with multiple processors. 
• Deleting measures or systems no longer occasionally causes subsequent staff list expressions to be deleted. 

 
Pickup Measures 

• Copying and pasting a pickup measure no longer clears the pickup measure definition. 
 
Playback 

• Adding new SmartMusic SoftSynth staves with the Staff Setup Wizard to a non-VST file no longer silences 
the previous staves. 

 
Speedy Entry 

• Unwanted accidentals no longer occasionally appear on the last note of a tie. 

 
Fixes in Finale 2010 
 
Chord and Fretboards 

• Removing manual adjustments on chord symbols and fretboards no longer deselects their handles. 
• Alignment arrows for positiong fretboards no longer continue to show when switching to a document 

without fretboards. 
• Position Fretboards no longer becomes checked when no fretboards are showing, then switching from a 

document where they are. 
 
Copying 

• Stack-copying and pasting music with a pickup measure no longer clears the pickup measure setting in the 
target document. 

• Copying a measure attached smart shape, and then changing the copied smart shape's measure assignment, 
no longer interferes with future copying. 

 
Document Options 



• The obsolete "Expressions" checkbox in Document Options-Music Spacing has been removed. 
 
Expressions 

• Layer Assignments for Expressions are now retained when copied. 
• Adding staves to an extracted part no longer causes Expressions (that were used in the original score) to 

appear in the newly added staves. 
• Deleting measures no longer causes Expressions assigned to Score Lists to disappear from parts. 

 
Exercise Wizard 

• NC and IL exercises are now installed. 
 
MIDI files 

• In a MIDI file, notes tied to the last note of a Tuplet now import correctly. 
 
Mixer 

• The Mixer window is no longer cut-off in Vista. 
 
Playback 

• The playback cursor is no longer displaced when playing multimeasure rests over time signatures. 
 
Scanning 

• SmartScore Lite now remembers the location of previous files. 
 
Smart Shapes 

• Glissando Smart Shapes will now copy when neither the source nor the target is a stack selection. 
 
Special Tools 

• Secondary Beam stubs no longer point the wrong direction in certain situations. 
 
Speedy Entry 

• Percussion notes can now be changed by dragging notes in Speedy Entry. 
 
Staff Tool 

• Notes hidden by staff styles no longer continue to display in some files. 
 
Stems 

• Stem side is now automatically fixed when adjacent notes on a percussion staff are moved apart vertically 
on the staff. 

• Imploding percussion staves no longer leaves notes on the wrong side of the stem. 
 
Tablature 

• String Alteration Note details are now retained when copying partial measures. 
• Fret numbers no longer stay hidden when automatically splitting notes tied over a barline in Speedy Entry. 

 
TempoTap 

• Copying to the Tempo Tap staff now copies layers other than 1. 
 
Text Tool 

• Dragging a page-attached text block with underline style no longer leaves artifacts. 
• Font sizes in Part Name text inserts are now preserved when the Linked Parts are extracted. 
• Extra items in the Text Menu > Inserts submenu (Value Number, Controller Number, and Pass Number) 

have been removed. These inserts can only be used when accessing the Inserts menu through the 
Expression Designer. 

• Text encoding is no longer cancelled when opening certain files. 



 
VST 

• Closing Finale when WIVI VST is loaded on no longer causes a crash 
 


